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CODE BANKING USING THE KEIL 8051 TooLs

1. Relevant Devices hold executable code or constant data. Figure 1
shows the code banking model implemented by
these devices. Instruction fetch operations (normal
code execution) are handled independently of con-
stant data operations (MOVC instructions, and
MOVX instructions when used for writing to
) FLASH). Each type of operation has its own bank
Introduction select bits that may select any of the 4 banks as
shown in Figure 1. All code bank switching is han-
dled at the device level by writing to the PSBANK
register. The COBANK and IFBANK bits in this
register control switching for constant code
accesses and instruction fetches, respectively. For
more information on code bank switching, please
refer to the C8051F12x datasheet.

This application note applies to the following devices:

C8051F120, C8051F121, C8051F122, C8051F123,
C8051F124, C8051F125, C8051F126, and
C8051F127.

The 8051 architecture supports a 64KB linear pro-
gram memory space. Devices that have more than
64KB of program memory implement a code bank-
ing scheme to surmount this 64KB limit. This
application note discusses software project man-
agement techniques and provides example applica-
tions that use code banking.

Figure 1. C8051F12x Code Banking
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For projects that require more than 64KB of code
space or non-volatile data space, the user has the
option of manually handling the bank switching in
software or setting up a code- banked project. Both
methods are discussed in this note.

User-Managed Bank
Switching for Data Intensive
Projects

User-managed bank switching is useful for projects
that have less than 64KB of executable code but
need to store large amounts of data in FLASH. In
this situation, the Common area and Bank 1 are
used for program memory while Bank 2 and
Bank 3 are used for data storage. The project does
not need to be set up for code banking.

The following data logging example shows how
bank switching can be managed in application soft-
ware.

Example 1. Data Logging
Application

This application uses a 22.1184 MHz crystal oscil-
lator to implement a software real-time clock
(RTC). PCAQ, configured to count Timer O over-
flows, generates an interrupt once every second.
The interrupt handler records the current time and
device temperature in a non-volatile log in FLASH.

The 112,640 byte log cycles through all 4 code
banks recording time and temperature. Each data
record has 6 fields as shown in Figure 2. The log is
capable of storing 14080 records over a time period
of 3.9 hours. Once the log is full, it continues log-

ging at the beginning of log, erasing the FLASH
page with the oldest data as it progresses.

Managing the Instruction Fetch Bank
Select

Since this application uses less than 32KB of
FLASH for program code, there will be no instruc-
tion fetches from the 0x8000 to OxFFFF memory
space. This makes the value of IFBANK a “don’t
care”. However, if an application uses between
32KB and 64KB of FLASH for program code,
IFBANK should be left at its reset value, targeting
Bank 1.

Advancing Through the Code Banks

This application reserves the first 16KB of FLASH
in the Common area for program code. The log
starts at address 0x4000 in the Common area and
ends at location OXF7FF in Bank 3 as shown in

Figure 2. Log Record Structure
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Figure 3.

After storing a record in the log, the FLASH write
pointer is advanced to the next record and checked
for code bank boundaries. There are three possible
boundary conditions to consider when adjusting the
FLASH write pointer. These cases are outlined in

Figure 3. FLASH Memory Map for

Example 1
—
0x0000
Common 16KB reserved
Area for program code
0x4000 0x0000
through
OX7FFF
OX7FFF
0x8000
Bank 1
0x8000 14080 x 8
through
OXFFFF Non-Volatile
OXFFFF Time
> and
0x8000 Temperature
Bank 2 Log
0x8000
through 112,640
OXFFFF bytes total
OXFFFF
0x8000
Bank 3
OXF7FF 0x8000
through
O0xF800 OXFFFF 1KB FLASH, Lock
Bits, and
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Table 1.

Preserving the PSBANK Register in
Functions and Interrupt Service
Routines

A program must preserve and restore the value of
the PSBANK register in every function and inter-
rupt service routine that switches code banks.

Choosing Log Record Size

Example 1 only writes entire records to FLASH. If
the record size is a power of 2 and the log starts at
the beginning of a FLASH page, then all records
will be contained within one of the code banks. If a
record can cross a bank boundary, then bounds
checking must be performed after every byte write.

Keeping Accurate Time

This application keeps track of time by implement-
ing an interrupt driven real-time clock. With
SYSCLK at 49.7664 MHZ, Timer 0 in mode 2
overflows exactly 4050 times every second when
clocked by SYSCLK/48. PCA Module 0 is config-
ured in “Software Timer Mode” to count Timer O
overflows and generate an interrupt every second.

Table 1. FLASH Write Pointer Boundary Conditions

Condition How to Detect

FLASH write pointer
reaches the end of the
Common area.

location 0x8000.

FLASH write pointer will point to

Typical Action

No action is necessary if COBANK is
always set to Bank 1 whenever the
pointer is moved to the beginning of the
log.

FLASH write pointer
reaches the end of
Bank 1 or Bank 2.

location 0x0000.

FLASH write pointer will point to

FLASH write pointer should be set to
0x8000 and COBANK should be incre-
mented.

FLASH write pointer
reaches the end of the

log. be selected by COBANK.

FLASH write pointer will point to
location 0xF800 and Bank 3 will

FLASH write pointer should be reset to
the first location in the log (0x4000) and
COBANK should select Bank 1.

Rev. 1.3 3
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Project-Managed Bank
Switching for Code-
Intensive Applications

The Keil 8051 development tools support code
banking by generating code that can automatically
switch and preserve the PSBANK register. This
allows the user to expand 64KB projects to 128KB
without modifying existing modules. Using the
code banking capability of the Silicon Labs IDE or
the Keil uVision2 for projects containing more than
64KB of program code is recommended to take
advantage of this feature.

To use the Keil 8051 tools for code banking, the
project needs to be configured. The configuration
required for code banking is supported in
Version 1.7 and later of the Silicon Labs IDE and
Version 2.00 and later of pVision2. Step-by-step
instructions on how to configure a Silicon Labs
IDE project and a pVision2 project for code bank-
ing are included in example 2.

Code banked projects typically contain multiple
source files, one or more for each code bank. This
greatly simplifies project configuration, as will be
shown in example 2. In addition to source files, all
projects configured for code banking must include
a code banked version of STARTUP.A51 and
L51 BANK.A51. These files can be found in the
Silicon Labs IDE installation  directory,
‘Cygnal\Examples\C8051F12x\Asm’

Example 2: Project-Managed
Code Banking

This example shows how to set up a code banked
project using the Keil development tools. It uses
Timer 3 and Timer 4 interrupts to blink the LED
and output a 1 kHz sine wave on DACL, respec-
tively. The code that blinks the LED is located in
Bank 3 and the code that outputs a sine wave is
located in Bank 2. Since interrupts must be located
in the Common area, both interrupts call a function
in one of the banks to perform the desired task.

This example contains three source files, one for
each bank and the Common area, and two required
project files, as listed in Table 2 .

Table 2. Files needed by Example 2

common.c

bank2.c

bank3.c

STARTUP.A51

L51_BANK.A51

Step by Step Instructions on
Configuring a Code Banked Project
Using the Silicon Labs IDE

The following steps show how to configure the
code banked example project using the Silicon
Labs IDE.

1. Start the Silicon Labs IDE and add the files
listed in Table 2 to a new project. Additionally,
an example project is included named ‘exam-
ple2.wsp’.

2. Open the Tool Chain Integration window from
the Project menu and select the Linker tab as
shown in Figure 4. Click on the Customize
button. A window similar to the one shown in
Figure 5 should appear on the screen. Select the
processor you are using from the pull down
menu. This enables code banking by adding the
BANKAREA directive to the linker command
line parameters. For more information on the
BANKAREA directive, please refer to Chapter 9
of the Keil Assembler/Linker manual,
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accessible in PDF format from the Help menu Select the Files to Link tab.

of the Silicon Labs IDE.

Figure 4. Tool Chain Integration
Window
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Figure 5. Linker Customization Window
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Figure 6. Target Build Configuration
Window
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Figure 7. Project Build Definition
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4. For each file in the Files To Be Linked list box,
select the desired bank from the Bank # pull
down menu. The ‘L51 BANK.obj” and
‘STARTUP.obj’ files should be located in the
Common area in all projects. The remaining
project files should be located in their respec-
tive code banks, as shown in Table 3.

3. Open the Target Build Configuration window Table 3. Code Bank Selection for Example 2

from the Project menu ar_md click the Cust_omlze Filename Code Bank
button, as shown in Figure 6. The window

shown in Figure 7 should appear on the screen. common.obj Common area
bank2.0bj Bank 2
bank3.0bj Bank 3
) Rev. 1.3 5
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Table 3. Code Bank Selection for Example 2

Filename Code Bank

STARTUP.0bj Common area

Common area

L51_BANK.0Dbj

Save the project by selecting Save Project from
the Project menu.

2.

Open the Options for Target window from the
Project menu and select the Target tab, as
shown in Figure 8. Click on the Code Banking
check box at the bottom on the window. Next,
select the number 4 from the Banks: pull down
menu. Finally, edit the Bank Area: text boxes
with a value of 0x8000 for the Start: value and
OxFFFF for the End: value. When the selec-
tions match those shown in Figure 8, press the

i . ] ) ) OK button to close the window.
6. Build the project by selecting Build/Make Proj-

ect from the Project menu. Figure 8. Options for Target Window
7. If the project has been configured correctly, an
‘example2.M51” map file will be generated in
the project folder. Inspect this file to verify that
functions have been located in the proper bank.
You should also notice that the sine table in
‘bank2.c’ has been located in the Common area

Dptions for Target ‘Target 1°

21x|
Deviculputl Listing | €51 | 451 | BLS1 Locate | BLS1 Mise | Debug | Utiiies |
Cyanal Integrated Products CA0S1F020

I~ Use Onchip ROM (0:0-04FFFF)

il (WHz), [EED
Smal variables in DATA

Memory Model

Code Rom Size: | Large: 64K program I~ Use Orvchip XAAM (0:0-04FFF)

[

Dperating system: [Nane

because it is a constant code variable. Refer to | [™™ ™™™ au se |0 s |
the Keil linker manual for a description of the E';j::,—,— ,—,—
M51 file. I ——
<l’7 Cods Banking Shart End “5 5 memory bupe suppott
. Banks: [¢ ~]  Barkdea W W ) e ki eersion SFF i et
Step by Step Instructions on ~ __—

[ o ] coeel | Defaurs

Configuring a Code Banked Project
Using pVision?2.
The following steps show how to configure the

code banked example project using the Keil IDE,
uVision2,

3. Each file now needs to be assigned to a code
bank or to the common area. Additionally,
groups of files can be created and banking
assignments made for the entire group. For
each file/group in the Project Workspace win-
dow, right-click on the file-name/group-name
and select Options for File/Options for Group,
as shown in Figure 9. The window shown in
Figure 10 should appear on the screen. Select
the desired bank from the Code Bank: pull
down menu. The ‘L51 BANK.obj” and
‘STARTUP.obj’ files should be located in the
Common area in all projects. The remaining
project files should be located in their respec-
tive code banks, as shown in Table 4 .

1. Start puVision2, create a new project and add the
files listed in Table 2 to the project. Addition-
ally, an example project is included named
‘example2.Uv2’.

4. Build the project by selecting Build target or
Rebuild all target files from the Project menu.

6 Rev. 1.3
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5. If the project has been configured correctly, an
‘example2.M51” map file will be generated in
the project folder. Inspect this file to verify that
functions have been located in the proper bank.
You should also notice that the sine table in
‘bank2.c’ has been located in the Common area
because it is a constant code variable. Refer to
the Keil linker manual for a description of the
M51 file.

Figure 9. Select “Options for File”

T example2 - pvision2
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Open bankz.c
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Remove File 'bank2.c'

[ v 1nchude Dependencies

Figure 10. Options for File Window
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Table 4. Code Bank Selection for Example 2

Filename Code Bank

common.obj Common area

bank2.0bj Bank 2
bank3.0bj Bank 3
STARTUP.0Dj Common area

Common area

L51_BANK.obj

Code Bank Assignment
Considerations

Assigning files to code banks is a straightforward
procedure. However, determining the best place-
ment of functions in code banks is largely depen-
dant on the nature of the project. This section
outlines some guidelines to follow when assigning
code banks.

The Common area is accessible by all code banks
at all times. It is important to keep all code that
must always be accessible in the Common area. For
example, reset and interrupt vectors, interrupt ser-
vice routines, code constants, bank switch code,
and library functions should always be located in
the Common area.

Assigning Code Banks for Maximum
Performance

Code bank switching does not significantly affect
the performance of most systems. However, to
achieve maximum performance in time critical
applications, programs should be structured so that
frequent bank switching is not necessary. Bank
switch code is not generated when the function
being called resides in the Common area or in the
same bank as its calling function. Placing fre-
guently accessed functions or functions called from
different banks in the Common area is essential to
achieve maximum performance in time critical
applications.

Rev. 1.3 7
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Code Constants

Code constants (strings, tables, etc.) are located in
the Common area by default. This is the best loca-
tion for code constants in most applications
because they can be accessed using the MOVC
instruction from any bank. If the Common area is
not large enough to accommodate all code con-
stants, they may be placed in one of the code banks
but may only be accessed from code executing
from the same bank in which they reside or the
common area. They may not be accessed from code
executing in another bank because the linker sets
the constant code bank to the same bank as the
instruction fetch bank. Constant data in a code bank
may be accessed from the common area only if the
bank in which they reside is the currently selected
bank. Figure 11 shows how to invoke a linker-man-
aged bank switch from C.

The BANKX linker control allows code constants to
be located outside the Common area. For details on
locating constant code variables in a code bank,
please see the Keil Knowledge Base article at http:/
/www.keil.com/support/docs/1615.htm.

Bank Switch Macros

The Keil 8051 tools support 3 modes of bank
switching defined in ‘L51 BANK.A51’. Bank
switching on the C8051F12x uses Mode 4 (bank
switching via user-provided code). This mode
allows the user to specify a macro for each code
bank that selects it in the PSBANK register.

The PSBANK register contains two bank selects,
COBANK for constant data and IFBANK for
instruction fetches. Using the ‘L51 BANK.A51’
supplied by Silicon Labs, the COBANK and

IFBANK always target the same code bank. This is
why constant code tables must be located in the
Common area or in the bank that accesses them.

The bank switch macros in ‘L51_BANK.A51’ may
be changed to keep COBANK fixed regardless of
the value of IFBANK. This would allow the user to
dedicate one bank for constant data operations
while using the other two banks for instruction
fetches only. This dedicated bank would be avail-
able to code executing in any bank or the Common
area.

The Common area may always be used for both
instruction fetches and data storage regardless of
the PSBANK register settings. For more informa-
tion on bank switch macros, please see Chapter 9
of the Keil Assembler/Linker manual accessible in
PDF format from the help menu of the Silicon Labs
IDE.

Figure 11. Invoking a Linker-Managed Bank Switch From C

// declare the following function prototype

switchbank(1);

extern void switchbank (unsigned char bank_number);

// switch to code bank 1

8 Rev. 1.3
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oftware Examples

Example 1. User-Managed Code Banking (Data Logger with Real-
Time Clock)

Copyright 2002 Cygnal Integrated Products, Inc.

AUTH: FB
DATE: 30 SEP 02

This application uses a 22.1184 MHz crystal oscillator to implement a
software real-time clock (RTC). PCA Module 0, configured to count Timer O
overflows in software timer mode, generates an interrupt every second.
The interrupt handler records the current time and device temperature

in a non-volatile log in FLASH.

With SYSCLK at 49.7664 MHZ, Timer O in mode 2 overflows exactly 4050 times
every second when clocked by SYSCLK/48. PCAO, clocked by Timer 0 overflows,
is programmed to generate an interrupt every 4050 Timer O overflows,

or once every second.

The 112,640 byte log cycles through all 4 code banks recording time and
temperature. Each data record is 8 bytes long. The log is capable of storing
14080 records over a time period of 3.9 hours. Once the log is full, it
continues logging at the beginning of log, erasing the FLASH page with

// the oldest data as it progresses.
//
// When this code is built, the linker generates two multiple call to segments
// warnings. These warnings are generated because the FLASH support routines
// are called from the main routine and from interrupts. These warnings have
// been accounted for in the code by disabling interrupts before calling any
// FLASH support routines.
//
//
// Target: C8051F12x
// Tool chain: KEIL C51 6.03 / KEIL EVAL C51
//
/)
// Includes
/)
#include <c8051f120.h> // SFR declarations
#include <stdio.h> // printf() and getchar()
) —
// 16-bit SFR Definitions for “F12x
/)
sfrl6 DP = 0x82; // data pointer
sfr16 ADCO = Oxbe; // ADCO data
sfr16 ADCOGT = 0xc4; // ADCO greater than window
sfri6 ADCOLT = 0xc6; // ADCO less than window
sfri6 RCAP2 = 0Oxca; // Timer2 capture/reload

) Rev. 1.3 9
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sfr16 RCAP3 = 0Oxca; // Timer3 capture/reload
sfr16 RCAP4 = 0Oxca; // Timer4 capture/reload
sfrl6 TMR2 = 0Oxcc; // Timer2
sfrl6 TMR3 = 0Oxcc; // Timer3
sfrl6 TMR4 = Oxcc; // Timer4
sfri16 DACO = 0xd2; // DACO data
sfri16 DAC1 = 0xd2; // DAC1 data
sfr16 PCAOCP5 = Oxel; // PCAO Module 5 capture
sfr16 PCAOCP2 = 0xe9; // PCAO Module 2 capture
sfri6 PCAOCP3 = Oxeb; // PCAO Module 3 capture
sfr16 PCAOCP4 = Oxed; // PCAO Module 4 capture
sfr16 PCAO = O0xf9; // PCAO counter
sfr16 PCAOCPO = Oxfb; // PCAO Module O capture
sfr16 PCAOCP1 = Oxfd; // PCAO Module 1 capture
[
// Type Definitions
/)
typedef union Ulnt { // Byte addressable unsigned int
unsigned int Int;
unsigned char Char[2];
} Ulnt;
typedef union Long { // Byte addressable long
long Long;
unsigned int Int[2];
unsigned char Char[4];
} Long;
typedef union ULong { // Byte addressable unsigned long
unsigned long ULong;
unsigned int Int[2];
unsigned char Char[4];
} ULong;
typedef struct Record { // LOG record structure
char start;
unsigned int hours;
unsigned char minutes;
unsigned char seconds;
unsigned int ADC_result;
char end;
} Record;
[~
// Global CONSTANTS
/)
#define TRUE 1
#define FALSE 0
#define EXTCLK 22118400 // External oscillator frequency in Hz
#define SYSCLK 49766400 // Output of PLL derived from
// (EXTCLK*9/4)
#define BAUDRATE 115200 // Baud rate of UART in bps
// Note: The minimum standard baud rate
// supported by the UARTO_Init routine
// in this file is 19,200 bps when
10 Rev. 1.3 )
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#define SAMPLERATE 2000

sbit LED
sbit SW2

P176;
P317;

#define LOG_START 0x04000L
#define LOG_END Ox1F800L
#define RECORD_LEN 8

#define START_OF_RECORD “:~

#define FLASH_PAGESIZE 1024
#define COBANK OxFO
#define COBANKO 0x00
#define COBANK1 0x10

#define COBANK2 0x20
#define COBANK3 0x30

// Global VARIABLES

unsigned char SECONDS
unsigned char MINUTES
unsigned int HOURS =

[« T

unsigned int ADC_RESULT = O;

bit LOG_FLAG = 0;

bit LOG_ERASED = 0;

void main(void);
void RTC_update(void);
void print_menu(void);

// initialization routines
void SYSCLK_Init(void);
void PORT_Init(void);

void UARTO_Init (void);
void ADCO_Init (void);

void Timer3_Init(int counts);

void RTC_Init (void);
void PCAO_ISR (void);

//

//

//
//

//
//
//
//

//

//

//
//
//
//
//
//

//
//
//

//
//

SYSCLK = 49_.76MHz.
The ADC sampling rate in Hz

LED="1" means ON
SW2="0" means switch pressed

Starting address of LOG
Last address in LOG + 1
Record length in bytes
Start of Record symbol

Number of bytes in each FLASH page
Bit mask for the high nibble of PSBANK

These macros define the bit mask values
for the PSBANK register used for
selecting COBANK. COBANK should always
be cleared then OR-Equaled (]=) with
the proper bit mask to avoid changing
the other bits in the PSBANK register

global RTC seconds counter
global RTC minutes counter
global RTC hours counter

holds the oversampled and averaged
result from ADCO

this flag is used to enable
and disable logging but does
not affect the real-time clock

this flag indicates that the
LOG has been erased.

SILICON LABS
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// FLASH support routines

void FLASH_PageErase (unsigned long addr);

void FLASH Write (unsigned long dest, char* src, unsigned int numbytes);
void FLASH ByteWrite (unsigned long dest, char dat);

void FLASH_Read ( char* dest, unsigned long src, unsigned int numbytes);
unsigned char FLASH_ByteRead (unsigned long addr);

// LOG support routines

void print_time(void);
void LOG_erase(void);

unsigned long find_current_record(void);

void LOG_print(char all_at_once);
void LOG_update(void);

/-
// MAIN Routine
YAt e L T LT
void main (void)
{
#define input_str_len 4 // buffer to hold characters entered
char input_str[input_str_len]; // at the command prompt
WDTCN = Oxde; // disable watchdog timer
WDTCN = Oxad;
PORT_Init Q; // initialize crossbar and GPIO
SYSCLK_Init ; // initialize oscillator
UARTO_Init Q; // initialize UARTO
ADCO_Init(); // initialize ADCO
RTC_Init O; // initializes Timer0 and the PCA
Timer3_Init(SYSCLK/SAMPLERATE) ; // initialize Timer3 to overflow
// and generate interrupts at
// <SAMPLERATE> Hz
// to implement a real-time clock
EA = 1; // enable global interrupts
print_menuQ); // print the command menu
while (1){
SFRPAGE = UARTO_PAGE;
printf(“\nEnter a command > “);
gets(input_str, input_str_len);
switch ( input_str[0] ){
case “1°: LOG_FLAG = 1;
SFRPAGE = UARTO_PAGE;
printf(*\nLogging has now started.\n”);
break;
case “27: LOG_FLAG = O;
12 Rev. 1.3 )
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SFRPAGE = UARTO_PAGE;
printf(*\nLogging has now stopped.\n”);
break;

case “37: LOG_FLAG = O;
LOG_erase();
SFRPAGE = UARTO_PAGE;
printf(*\nThe log has been erased and logging is stopped.\n”);
break;

case “47: LOG_print(FALSE);
print_menuQ);
break;

case “57: LOG_print(TRUE);
print_menu();
break;

case “67: print_time(Q);
break;

case “?7: print_menu(Q);
break;

default: printf(*\n*** Unknown Command.\n’’);
break;

}

} 7/ end while

void RTC_update(void)
{
SECONDS++;
if (SECONDS == 60) {
SECONDS = 0;
MINUTES++;
if (MINUTES == 60) {
MINUTES = 0;
HOURS++;

Rev. 1.3 13
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//

// This function erases the FLASH page containing <addr>.

//

void FLASH_PageErase (unsigned long addr)

{
char SFRPAGE_SAVE = SFRPAGE; // Preserve current SFR page
char PSBANK_SAVE = PSBANK; // Preserve current code bank
bit EA SAVE = EA; // Preserve interrupt state
ULong temp_addr; // Temporary UlLong
char xdata * idata pwrite; // FLASH write/erase pointer
temp_addr.ULong = addr; // copy <addr> to a byte addressable

// unsigned long

// Extract address information from <addr>
pwrite = (char xdata *) temp_addr.Int[1];

// Extract code bank information from <addr>

PSBANK &= ~COBANK; // Clear the COBANK bits
if( temp_addr.Char[1] == 0x00){ // IT the address is less than
// 0x10000, the Common area and
PSBANK |= COBANK1; // Bankl provide a 64KB linear
// address space
} else { // Else, Bank2 and Bank3 provide

// a 64KB linear address space

if (temp_addr.Char[2] & 0x80){ // If bit 15 of the address is
// a “1”, then the operation should
PSBANK |]= COBANK3; // target Bank3, else target Bank2

} else {
PSBANK |= COBANK2;

temp_addr.Char[2] |= 0x80;
pwrite = (char xdata *) temp_addr.Int[1];

b

}
SFRPAGE = LEGACY_PAGE;
EA = 0; // Disable interrupts
FLSCL |= 0xO01; // Enable FLASH writes/erases
PSCTL = 0x03; // MOVX erases FLASH page
*pwrite = 0; // Initiate FLASH page erase
FLSCL &= ~0x01; // Disable FLASH writes/erases
PSCTL = 0x00; // MOVX targets XRAM
EA = EA_SAVE; // Restore interrupt state
PSBANK = PSBANK_SAVE; // Restore current code bank
SFRPAGE = SFRPAGE_SAVE; // Restore SFR page

by

[/ -

// FLASH Write

14 Rev. 1.3
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//

// This routine copies <numbytes> from <src> to the FLASH addressed by <dest>.
//

void FLASH Write (unsigned long dest, char* src, unsigned int numbytes)

{

unsigned int i; // Software Counter
for (i = 0; i < numbytes; i++) {

FLASH_ByteWrite( dest++, *src++);

¥
}
[
// FLASH_ByteWrite
/)
//
// This routine writes <dat> to the FLASH byte addressed by <dest>.
//
void FLASH ByteWrite (unsigned long dest, char dat)
{
char SFRPAGE_SAVE = SFRPAGE; // Preserve current SFR page
char PSBANK_SAVE = PSBANK; // Preserve current code bank
bit EA SAVE = EA; // Preserve interrupt state
ULong temp_dest; // Temporary UlLong
char xdata * idata pwrite; // FLASH write/erase pointer
temp_dest._ULong = dest; // copy <dest> to a byte

// addressable unsigned long

// Check if data byte being written is OxFF

// There is no need to write OxFF to FLASH since erased
// FLASH defaults to OxFF.

if(dat '= OxFF){

// Extract address information from <dest>
pwrite = (char xdata *) temp_dest.Int[1];

// Extract code bank information from <addr>

PSBANK &= ~COBANK; // Clear the COBANK bits

if( temp_dest.Char[1] == O0x00){ // If the address is less than
// 0x10000, the Common area and

PSBANK |= COBANK1; // Bankl provide a 64KB linear
// address space
} else { // Else, Bank2 and Bank3 provide

// a 64KB linear address space
if (temp_dest.Char[2] & 0x80){// 1T bit 15 of the address is

// a “1”, then the operation should
PSBANK |]= COBANK3; // target Bank3, else target Bank2

} else {
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PSBANK |]= COBANK2;
temp_dest._Char[2] |= 0x80;
pwrite = (char xdata *) temp_dest.Int[1];
3
3

SFRPAGE = LEGACY_PAGE;

EA = 0; // Disable interrupts
FLSCL |= Ox01; // Enable FLASH writes/erases
PSCTL = 0x01; // MOVX writes FLASH byte
*pwrite = dat; // Write FLASH byte
FLSCL &= ~0x01; // Disable FLASH writes/erases
PSCTL = 0x00; // MOVX targets XRAM
}
EA = EA SAVE; // Restore interrupt state
PSBANK = PSBANK_ SAVE; // Restore current code bank
SFRPAGE = SFRPAGE_SAVE; // Restore SFR page
}
// -
// FLASH_Read
) —
//

// This routine copies <numbytes> from FLASH addressed by <src> to <dest>.
//
void FLASH_Read ( char* dest, unsigned long src, unsigned int numbytes)

{
unsigned int i; // Software Counter
for (i = 0; i < numbytes; i++) {

*dest++ = FLASH_ByteRead(src++);

//

// This routine returns to the value of the FLASH byte addressed by <addr>.
//

unsigned char FLASH_ByteRead (unsigned long addr)

{
char SFRPAGE_SAVE = SFRPAGE; // Preserve current SFR page
char PSBANK_SAVE = PSBANK; // Preserve current code bank
ULong temp_addr; // Temporary UlLong
char temp_char; // Temporary char
char code * i1data pread; // FLASH read pointer
temp_addr.ULong = addr; // copy <addr> to a byte addressable
// unsigned long
16 Rev. 1.3 )
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// Extract address information from <addr>
pread = (char code *) temp_addr.Int[1];

// Extract code bank information from <addr>

PSBANK &= ~COBANK; // Clear the COBANK bits
iT( temp_addr.Char[1] == 0x00){ // IT the address is less than
// 0x10000, the Common area and
PSBANK |= COBANK1; // Bankl provide a 64KB linear
// address space
} else { // Else, Bank2 and Bank3 provide

// a 64KB linear address space

if (temp_addr.Char[2] & 0x80){ // 1T bit 15 of the address is
// a “1”, then the operation should
PSBANK |= COBANK3; // target Bank3, else target Bank2

} else {

PSBANK |= COBANK2;
temp_addr.Char[2] |= 0x80;
pread = (char code *) temp_addr.Int[1];
}
¥

temp_char = *pread; // Read FLASH byte

PSBANK = PSBANK_SAVE; // Restore current code bank
SFRPAGE = SFRPAGE_SAVE; // Restore SFR page

return temp_char;

//
// This routine uses prints the command menu to the UART.
//
void print_menu(void)
{
char SFRPAGE_SAVE = SFRPAGE; // Save Current SFR page

SFRPAGE = UARTO_PAGE;

printfF(*\n\nC8051F12x Data Logging Example\n’”);

printf(*“-----— - \n”");

printf(*“1. Start Logging\n™);

printf(“2. Stop Logging\n”);

printf(“3. Erase Log\n”);

printf(“4. Print Log (one page at a time - Press CTRL+C to stop)\n”);
printf(“5. Print Log (all at once - Press CTRL+C to stop)\n”);
printf(“6. Print Elapsed Time Since Last Reset\n”);

printf(*“?. Print Command List\n™);
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SFRPAGE = SFRPAGE_SAVE; // Restore SFR page
}

//

// This routine uses prints the elapsed time since the last reset to the UART.
//

void print_time(void)

{
char SFRPAGE_SAVE = SFRPAGE; // Save Current SFR page
bit EA_SAVE = EA; // Preserve interrupt state
SFRPAGE = UARTO_PAGE;
EA = 0O;
printf (“%05u:%02bu:%02bu\n”’, HOURS, MINUTES, SECONDS);
EA = EA_SAVE;
SFRPAGE = SFRPAGE_SAVE; // Restore SFR page
}
/Yy -
// find_current_record
/-
//
//
unsigned long find_current_record(void)
{
char SFRPAGE_SAVE = SFRPAGE; // Save Current SFR page
bit EA_SAVE = EA; // Preserve interrupt state
unsigned long pRead = LOG_START; // Pointer used to read from FLASH
unsigned int i; // Software counter
bit record_erased; // Temporary flag
// Keep skipping records until an uninitialized record is found or
// until the end of the log is reached
while( pRead < LOG_END ){
EA = 0O;
// Skip all records that have been initialized
i T(FLASH_ByteRead(pRead) == START_OF_RECORD ){
// increment pRead to the next record
pRead += RECORD_LEN;
EA = EA_SAVE;
continue;
}
// Verify that the Record is uninitialized, otherwise keep
// searching for an uninitialized record
record_erased = 1;
for(i = 0; 1 < RECORD_LEN; i++){
iT( FLASH_ByteRead(pRead+i) != OxFF ){
record_erased = 0O;
}
18 Rev. 1.3 )
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}

if(lrecord_erased){
// increment pRead to the next record
pRead += RECORD_LEN;
EA = EA_SAVE;
continue;

}
EA = EA_SAVE;

// When this code is reached, <pRead> should point to the beginning
// of an uninitialized (erased) record;

SFRPAGE = SFRPAGE_SAVE; // Restore SFR page

return pRead;

}

// This code is reached only when there are no uninitialized records
// in the LOG. Erase the First FLASH page in the log and return
// a pointer to the first record in the log.

EA = 0;
FLASH_PageErase(LOG_START); // Erase the first page of the LOG
EA = EA_SAVE;
SFRPAGE = SFRPAGE_SAVE; // Restore SFR page
return LOG_START;
}
/-
// LOG_erase
/-
//
//
void LOG_erase(void)
{
unsigned long pWrite = LOG_START; // pointer used to write to FLASH
bit EA_SAVE = EA; // save interrupt status
// Keep erasing pages until <pWrite> reaches the end of the LOG.
while( pWrite < LOG_END ){
EA = 0O;
FLASH_PageErase(pWrite);
EA = EA_SAVE;
pWrite += FLASH_PAGESIZE;
}
LOG_ERASED = 1; // flag that LOG has been erased
}
// -
// LOG_print
/-
//
//
void LOG_print(char all_at_once)
{
char SFRPAGE_SAVE = SFRPAGE; // Save Current SFR page
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bit EA_SAVE = EA; // save interrupt status
unsigned long pRead = LOG_START; // Pointer used to read from FLASH
Record temp_rec; // Temporary record

// Keep printing records until the end of the log is reached
while( pRead < LOG_END ){

// Copy a record from at <pRead> from the LOG into the local
// Record structure <temp_rec>

EA = 0;

FLASH_Read( (char*) &temp_rec, pRead, RECORD_LEN);

EA = EA_SAVE;

// Validate Record

if(temp_rec.start = “:7){
SFRPAGE = SFRPAGE_SAVE; // Restore SFR page
return;

}

// Print the Record
SFRPAGE = UARTO_PAGE;

RIO = 0; // Clear UART Receive flag
// to later check for the
// user pressing CTRL+C

EA = 0; // disable interrupts

// print the time and ADC reading

printf (“%05u:%02bu:%02bu ADC = 0x%04X\n”, temp_rec.hours,
temp_rec.minutes,
temp_rec.seconds,
temp_rec.ADC_result);

EA = EA_SAVE; // restore interrupts
// any pending interrupts will
// be handled immediatly
// check if we need to continue

// if printing all data at once do not stop printing unless
// the user presses CTRL+C, otherwise print 16 records and
// then prompt user to press any key

if(all_at_once){
// Check if user has pressed CTRL+C
if(RI0 && SBUFO == 0x03){
R10 = O;
SFRPAGE = SFRPAGE_SAVE; // Restore SFR page
return;

}

// pause every 16 lines
} else if( (pRead & ((RECORD_LEN*16)-1)) == 0 &&
pRead > (LOG_START + RECORD_LEN)) {

20
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// wait for a key to be pressed then check if user has

// pressed CTRL+C (0x03)

printf(“\npress any key to continue\n”);

if(getkey() == 0x03) {
SFRPAGE = SFRPAGE_SAVE; // Restore SFR page
return;

}

¥

// increment pRead to the next record
pRead += RECORD_LEN;

SFRPAGE = SFRPAGE_SAVE; // Restore SFR page

void LOG_update(void)

{

bit EA_SAVE = EA; // Preserve interrupt state
Record temp_record; // local LOG record structure

static unsigned long pWrite = LOG_START;

// pointer used to write to the LOG
bit record_erased; // temporary flag
unsigned int i; // temporary integer

// record the time and ADC reading in the LOG if logging is enabled
iF(LOG_FLAG){

if(LOG_ERASED){
pWrite = LOG_START;
LOG_ERASED = 0;

} else {

// find the current record if the record at pWrite is not erased
record erased = 1;
for(i 0; 1 < RECORD_LEN; i++){
EA = 0;
iT( FLASH_ByteRead(pWrite+i) = OxFF ){
record_erased = 0;

}
EA = EA_SAVE;

}
if(lrecord_erased){
pWrite = find_current_record();

}

// build the temporary record
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temp_record.start = START_OF_RECORD;
temp_record.hours = HOURS;
temp_record.minutes = MINUTES;
temp_record.seconds = SECONDS;
temp_record.ADC_result = ADC_RESULT;

// write the temporary record to FLASH
EA = 0;
FLASH_Write( pWrite, (char*) &temp_record, RECORD_LEN);

EA = EA_SAVE;

// increment record pointer

pWrite += RECORD_LEN;

// if <pWrite> is past the end of the LOG, reset to the top

if(pWrite >= LOG_END){
LOG_START;

}

pWrite =

} 7/ end else
} 7/ end if(LOG_FLAG)

}
S —
// Initialization Routines
/)
/)
// SYSCLK_Init
) —
//
// This routine initializes the system clock to use an external 22.1184 MHz
// crystal oscillator multiplied by a factor of 9/74 using the PLL as its
// clock source. The resulting frequency is 22.1184 MHz * 9/4 = 49.7664 MHz
//
void SYSCLK_Init (void)
{

int i; // delay counter

char SFRPAGE_SAVE = SFRPAGE; // Save Current SFR page

SFRPAGE = CONFIG_PAGE; // set SFR page

OSCXCN = 0x67; // start external oscillator with

// 22_.1184MHz crystal

for (i=0; i < 256; i++) ; // Wait for osc. to start up

while (T(OSCXCN & 0x80)) ; // Wait for crystal osc. to settle

CLKSEL = 0x01; // Select the external osc. as

// the SYSCLK source

OSCICN = 0x00; // Disable the internal osc.

//Turn on the PLL and increase the system clock by a factor of M/N = 9/4
22 Rev. 1.3 )
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//

SFRPAGE = CONFIG_PAGE;
PLLOCN = 0x04;
SFRPAGE = LEGACY_PAGE;
FLSCL = 0x10;
SFRPAGE = CONFIG_PAGE;
PLLOCN |]= 0x01;
PLLODIV = 0x04;
PLLOFLT = 0x01;
PLLOMUL = 0x09;

for (i=0; i1 < 256; i++) ;
PLLOCN |= 0x02;

while(1 (PLLOCN & 0x10));
CLKSEL = 0x02;

SFRPAGE = SFRPAGE_SAVE;

// This routine configures the

//

void PORT_Init (void)

{

//
//
//
//
//
//
//
//
//
//
//

char SFRPAGE_SAVE = SFRPAGE;

SFRPAGE =
XBRO

XBR1
XBR2

POMDOUT |
PAMDOUT |

SFRPAGE

CONFIG_PAGE;
0x04;

0x00;
0x40;

0x01;
0x40;

SFRPAGE_SAVE;

//

//
//

//
//
7/
//
//
//
//
//
//
//

//

//

7/

//

/7/

//

//

//

Set PLL source as external osc.

Set FLASH read time for 50MHz clk
or less

Enable Power to PLL

Set Pre-divide value to N (N = 4)
Set the PLL filter register for

a reference clock from 19 - 30 MHz
and an output clock from 45 - 80 MHz
Multiply SYSCLK by M (M = 9)

Wait at least 5us

Enable the PLL

Wait until PLL frequency is locked
Select PLL as SYSCLK source

Restore SFR page

Crossbar and GPIO ports.

Save Current SFR page

set SFR page

Enable UARTO

Enable crossbar and weak pull-up
Set TXO pin to push-pull

Set P1.6(LED) to push-pull

Restore SFR page

Configure the UARTO using Timerl, for <baudrate> and 8-N-1. In order to

increase the clocking flexibility of TimerO, Timerl is configured to count

SYSCLKs.

To use this routine SYSCLK/BAUDRATE/16 must be less than 256. For example,

if SYSCLK = 50 MHz, the lowest standard baud rate supported by this
routine is 19,200 bps.

void UARTO_Init (void)

SILICON LABS
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{
char SFRPAGE_SAVE = SFRPAGE; // Save Current SFR page
SFRPAGE = UARTO_PAGE;
SCONO = 0x50; // SCONO: mode O, 8-bit UART, enable RX
SSTAO = 0x10; // Timer 1 generates UARTO baud rate and
// UARTO baud rate divide by two disabled
SFRPAGE = TIMERO1_PAGE;
TMOD &= ~OxFO;
TMOD |= 0x20; // TMOD: timer 1, mode 2, 8-bit reload
TH1 = -(SYSCLK/BAUDRATE/16); // Set the Timerl reload value
// When using a low baud rate, this equation
// should be checked to ensure that the
// reload value will fit in 8-bits.
CKCON |= 0x10; // TIM = 1; SCA1l:0 = xx
TL1 = TH1; // initialize Timerl
TR1 = 1; // start Timerl
SFRPAGE = UARTO_PAGE;
TIO = 1; // Indicate TXO0 ready
SFRPAGE = SFRPAGE_SAVE; // Restore SFR page
}
/)
// ADCO_Init
)~
//
// Configure ADCO to start conversions on Timer3 Overflows and to
// use left-justified output mode.
//
void ADCO_Init (void)
{
char SFRPAGE_SAVE = SFRPAGE; // Save Current SFR page
SFRPAGE = ADCO_PAGE;
ADCOCN = 0x85; // ADCO enabled; normal tracking
// mode; ADCO conversions are initiated
// on Timer3 overflows; ADCO data is
// left-justified
REFOCN = 0xO07; // enable temp sensor, on-chip VREF,
// and VREF output buffer
AMXOSL = OxOF; // Select TEMP sens as ADC mux output
ADCOCF = ((SYSCLK/2500000) << 3);// ADC conversion clock = 2_5MHz
ADCOCF |= 0x01; // PGA gain = 2
EIE2 |= Ox02; // Enable ADCO End-of-conversion
// interrupts
SFRPAGE = SFRPAGE_SAVE; // Restore SFR page
24 Rev. 1.3 )
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// This routine initializes Timer3 in auto-reload mode to overflow
// at intervals specified in <counts>.

//
void Timer3_Init (int counts)
{
SFRPAGE = TMR3_PAGE;
TMR3CN = O; // STOP timer; set to auto-reload mode
TMR3CF = 0x08; // Timer3 counts SYSCLKs
RCAP3 = -counts; // set reload value
TMR3 = RCAP3;
TR3 = 1; // start Timer3
by
[/
// RTC_Init
/)
//

// This Routine initializes Timer0O and PCAO to implement a real-time clock.
// Assuming <SYSCLK> is generated from a 22.1184 crystal oscillator, TimerO
// overflows exactly 1800 times per second when configured as an 8-bit timer
// that uses <SYSCLK>/48 as its timebase. PCAO is configured to count
// TimerO overflows and interrupt every 1800 TimerO overflows, or every second.
// The PCAO ISR updates a set of global RTC counters for seconds, minutes, hours,
// and days.
//
void RTC_Init(void)
{
char SFRPAGE_SAVE = SFRPAGE; // Save Current SFR page

SFRPAGE = TIMERO1_PAGE;

// configure TimerO in Mode2: 8-bit Timer with Auto-Reload

TMOD &= ~OxOF; // Clear TimerO bits
TMOD |= 0x02; // Mode2 Auto-Reload
// configure TimerO timebase to <SYSCLK>/48

CKCON &= ~0xOF; // Clear bits

CKCON |= 0x02; // Set TimerO timebase

// configure PCAO to count TimerO overflows
PCAOMD = 0x04;

// configure capture/compare module O to generate an interrupt when
// the value of PCAO reaches 4050 (OxOFD2)

PCAOCPO = 4050; // Set the value to match
PCAOCPMO &= ~OxFF; // Clear bits
PCAOCPMO |= 0x49; // Generate an interrupt when the
// PCAO value matches PCAOCPO
EIE1 |= 0x08; // Enable PCAO interrupts
) Rev. 1.3 25
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TRO = 1; // Start TimerO
PCAOCN |= 0x40; // Enable PCAO
SFRPAGE = SFRPAGE_SAVE; // Restore SFR page
}
/)~
// PCAO_ISR
[
//
//
void PCAO_ISR (void) interrupt 9
{
if (CCFO) {
CCFO = 0; // clear ModuleO capture/compare flag
PCAO = 0x00; // clear the PCA counter
RTC_update(); // update RTC variables
LOG_update(); // update LOG if logging is enabled
} else
if (CCF1) {
CCF1 = 0; // clear Modulel capture/compare flag
} else
if (CCF2) {
CCF2 = 0; // clear Module2 capture/compare flag
} else
if (CCF3) {
CCF3 = 0; // clear Module3 capture/compare flag
} else
if (CCF4) {
CCF4 = 0; // clear Module4 capture/compare flag
} else
if (CCF5) {
CCF5 = 0; // clear Module5 capture/compare flag
} else
if (CF) {
CF = 0; // clear PCA counter overflow flag
}
}
/)
// ADCO_ISR
S
//
// This ISR is called on the end of an ADCO conversion.
//
void ADCO_ISR (void) interrupt 15
{
26 Rev. 1.3 )
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static Long result = {0};

int i;

bit EA_SAVE = EA;

//accumulate 256 temperature samples
result_Long += ADCO;

i++;

if( i == 256 ) {

i =0;

// byte addressable long variable

// take the average (Divide by 256 = shift right by 8)

// Do this operation “result.Long >>= 8;” (170 SYSCLK cycles) using
// three MOV instructions (9 SYSCLK cycles)
// Assume Most Significant Byte only contains sign information

result._Char[3]
result._Char[2]
result_Char[1]

result_Char[2];
result_Char[1];
result_Char[0];

// update global <ADC_RESULT>
ADC_RESULT = result.Int[1];

SILICON LABS
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E

//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//

xample 2: Project-Managed Code Banking

Copyright 2002 Cygnal Integrated Products, Inc.

AUTH: FB
DATE: 18 SEP 02

This example shows how to set up a code banking project using the Cygnal
IDE and the KEIL development tools. It uses Timer3 and Timer4 interrupts
to blink the LED and output a 1 kHz sine wave on DACl, respectively. The
code that blinks the LED is located in Bank 3 and the code that outputs a
sine wave based on a 256 entry sine table is located in Bank 2. Since
interrupts must be located in the Common area, both interrupts call

a function in one of the banks to perform the desired task.

The project should be configured for code banking as shown in ANO30 before
this project is built.

This program uses the the 24.5 MHz internal oscillator multiplied by two

// for an effective SYSCLK of 49 MHz. This program also initializes UART1

// at <BAUDRATE> bits per second.

//

//

// Target: C8051F12x

// Tool chain: KEIL C51 6.03 /7 KEIL EVAL C51

//

/)~ -
// Includes

[/ ——————
#include <c8051f120.h> // SFR declarations

#include <stdio.h> // printf() and getchar()
/)~
// 16-bit SFR Definitions for “F12x

[/ ——————
sfri6 DP = 0x82; // data pointer

sfrl6 ADCO = Oxbe; // ADCO data

sfrl6 ADCOGT = 0Oxc4; // ADCO greater than window

sfr1l6 ADCOLT = 0xc6; // ADCO less than window

sfr16 RCAP2 = 0xca; // Timer2 capture/reload

sfri6 RCAP3 = 0Oxca; // Timer3 capture/reload

sfri6 RCAP4 = Oxca; // Timer4 capture/reload

sfrl6 TMR2 = 0Oxcc; // Timer2

sfrl6 TMR3 = 0Oxcc; // Timer3

sfr1l6 TMR4 = 0xcc; // Timer4

sfr16 DACO = 0xd2; // DACO data

sfri6 DAC1 = 0xd2; // DAC1 data

sfri6 PCAOCP5 = Oxel; // PCAO Module 5 capture

sfrli6 PCAOCP2 = 0xe9; // PCAO Module 2 capture

sfr16 PCAOCP3 = Oxeb; // PCAO Module 3 capture

sfr16 PCAOCP4 = Oxed; // PCAO Module 4 capture

sfr1i6 PCAO = 0xf9; // PCAO counter

sfr16 PCAOCPO = Oxfb; // PCAO Module O capture

sfr16 PCAOCP1 = Oxfd; // PCAO Module 1 capture
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// Global CONSTANTS

#define TRUE 1
#define FALSE 0
#define INTCLK 24500000
#define SYSCLK 49000000
#define BAUDRATE 115200

#define SAMPLE_RATE_DAC 100000L
#define PHASE_PRECISION 65536

shit LED
shit SwW2

P176;
P377;

#define FREQUENCY 1000

//
//
//

//
//

//
//

//
//

//
//

Internal oscillator frequency in Hz
Output of PLL derived from (INTCLK*2)
Baud rate of UART in bps

DAC sampling rate in Hz
range of phase accumulator

LED="1" means ON
SW2="0" means switch pressed

frequency of output waveform in Hz
<phase_add> is the change in phase

between DAC1 samples; It is used in
the set DAC1 routine in bank2

unsigned int phase add = FREQUENCY * PHASE_PRECISION / SAMPLE_RATE_DAC;

// Common area functions
void main(void);

void SYSCLK_Init(void);

void PORT_Init(void);

void UART1 Init (void);

void DAC1_Init (void);

void Timer3_Init(int counts);
void Timer4_Init(int counts);

// code bank 2 functions
extern void set DACl(void);

// code bank 3 functions
extern void toggle_ LED(void);

void main (void)

{

WDTCN
WDTCN

Oxde;
Oxad;

PORT_Init Q;
SYSCLK_Init Q;
UARTL_Init Q;
DAC1_Init Q;

Timer3_Init(SYSCLK/12/1000);

//

//
//
//
//

//

disable watchdog timer

initialize crossbar and GPIO
initialize oscillator
initialize UART1

initialize DAC1

initialize Timer3 to overflow

SILICON LABS
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// every millisecond
Timerd_Init(SYSCLK/SAMPLE_RATE_DAC);// initialize Timer4 to overflow
// <SAMPLE_RATE_DAC> times per
// second
EA = 1; // enable global interrupts
while(l);
}
[
// Interrupt Service Routines
/[
/-
// Timer3_ISR
/-
// This routine changes the state of the LED whenever Timer3 overflows 250 times.
//
// NOTE: The SFRPAGE register will automatically be switched to the Timer 3 Page
// When an interrupt occurs. SFRPAGE will return to its previous setting on exit
// from this routine.
//
void Timer3_ISR (void) interrupt 14
{
static int i; // software interrupt counter
TF3 = 0; // clear Timer3 overflow flag
i++; // increment software counter
// toggle the LED every 250ms
if (i == 250) {
toggle LEDQ); // toggle the green LED
i =0; // clear software counter
3
}
/)
// Timerd4 ISR -- Wave Generator
/-
//
// This ISR is called on Timer4 overflows. Timer4 is set to auto-reload mode
// and is used to schedule the DAC output sample rate in this example.
// Note that the value that is written to DAC1l during this ISR call is
// actually transferred to DAC1l at the next Timer4 overflow.
//
void Timer4_ISR (void) interrupt 16
{
TF4 = 0O; // clear Timer4 overflow flag
set_DAC1();
}
/-
// Initialization Routines
/)
// -

// SYSCLK_Init
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//

// This routine initializes the system clock to use the internal oscillator
// at 24.5 MHz multiplied by two using the PLL.

//
void SYSCLK_Init (void)
{
int i; // software timer
char SFRPAGE_SAVE = SFRPAGE; // Save Current SFR page
SFRPAGE = CONFIG_PAGE; // set SFR page
OSCICN = 0x83; // set internal oscillator to run
// at its maximum frequency
CLKSEL = 0x00; // Select the internal osc. as
// the SYSCLK source
//Turn on the PLL and increase the system clock by a factor of M/N = 2
SFRPAGE = CONFIG_PAGE;
PLLOCN = 0xO00; // Set internal osc. as PLL source
SFRPAGE = LEGACY_PAGE;
FLSCL = 0x10; // Set FLASH read time for 50MHz clk
// or less
SFRPAGE = CONFIG_PAGE;
PLLOCN |]= 0x01; // Enable Power to PLL
PLLODIV = 0xO01; // Set Pre-divide value to N (N = 1)
PLLOFLT = OxO01; // Set the PLL filter register for
// a reference clock from 19 - 30 MHz
// and an output clock from 45 - 80 MHz
PLLOMUL = 0x02; // Multiply SYSCLK by M (M = 2)
for (i=0; i1 < 256; i++) ; // Wait at least 5us
PLLOCN |= 0x02; // Enable the PLL
while('(PLLOCN & 0x10)); // Wait until PLL frequency is locked
CLKSEL = 0x02; // Select PLL as SYSCLK source
SFRPAGE = SFRPAGE_SAVE; // Restore SFR page
}
/e
// PORT_Init
[~
//
// This routine configures the crossbar and GPI0O ports.
//
void PORT_Init (void)
{
char SFRPAGE_SAVE = SFRPAGE; // Save Current SFR page
SFRPAGE = CONFIG_PAGE; // set SFR page
XBRO = 0x00;
XBR1 = 0x00;
XBR2 = 0x44; // Enable crossbar and weak pull-up
// Enable UART1
) Rev. 1.3 31
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POMDOUT |= 0x01; // Set TX1 pin to push-pull

PIMDOUT |= 0x40; // Set P1.6(LED) to push-pull

SFRPAGE = SFRPAGE_SAVE; // Restore SFR page
}
/)~
// UART1_Init
[
//

// Configure the UART1 using Timerl, for <baudrate> and 8-N-1.
//
void UART1_Init (void)

{
char SFRPAGE_SAVE = SFRPAGE; // Save Current SFR page
SFRPAGE = UART1_PAGE;
SCON1 = 0x10; // SCON1: mode 0, 8-bit UART, enable RX
SFRPAGE = TIMERO1l_PAGE;
TMOD &= ~0xFO;
TMOD |= 0x20; // TMOD: timer 1, mode 2, 8-bit reload
iT (SYSCLK/BAUDRATE/2/256 < 1) {
TH1 = -(SYSCLK/BAUDRATE/?2);
CKCON |= 0x10; // TIM = 1; SCA1:0 = xx
} else if (SYSCLK/BAUDRATE/2/256 < 4) {
TH1 = -(SYSCLK/BAUDRATE/2/4);
CKCON &= ~0x13; // Clear all T1 related bits
CKCON ]= 0x01; // TIM = 0; SCA1:0 = 01
} else if (SYSCLK/BAUDRATE/2/256 < 12) {
TH1 = -(SYSCLK/BAUDRATE/2/12);
CKCON &= ~0x13; // TIM = 0; SCA1:0 = 00
} else {
TH1 = -(SYSCLK/BAUDRATE/2/48);
CKCON &= ~0x13; // Clear all T1 related bits
CKCON |= 0x02; // TIM = 0; SCA1:0 = 10
}
TL1 = TH1; // initialize Timerl
TR1 = 1; // start Timerl
SFRPAGE = UART1_ PAGE;
TI1 = 1; // Indicate TX1 ready
SFRPAGE = SFRPAGE_SAVE; // Restore SFR page
by
[/ -
// DAC1_Init
/)~
//

// Configure DAC1 to update on Timer4 overflows and enable the the VREF buffer.
//
//
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VO

id DACL_Init(void){
char SFRPAGE_SAVE = SFRPAGE;
SFRPAGE = DAC1_PAGE;

DACICN = 0x94;
SFRPAGE = LEGACY_PAGE;

REFOCN |= 0x03;

//

//
/7

7/

Save Current SFR page

Enable DAC1 in left-justified mode
managed by Timer4 overflows

Enable the internal VREF (2.4v) and

// the Bias Generator
SFRPAGE = SFRPAGE_SAVE; // Restore SFR page
}
/)
// Timer3_Init
) —
//
// Configure Timer3 to auto-reload mode and to generate interrupts
// at intervals specified by <counts> using SYSCLK/12 as its time base.
//
//
void Timer3_Init (int counts)
{
char SFRPAGE_SAVE = SFRPAGE; // Save Current SFR page
SFRPAGE = TMR3_PAGE;
TMR3CN = 0x00; // Stop Timer; Clear overflow flag;
// Set to Auto-Reload Mode
TMR3CF = 0x00; // Configure Timer to increment;
// Timer counts SYSCLKs/12
RCAP3 = -counts; // Set reload value
TMR3 = RCAP3; // Initialize Timer to reload value
EIE2 |= 0x01; // enable Timer3 interrupts
TR3 = 1; // start Timer
SFRPAGE = SFRPAGE_SAVE; // Restore SFR page
}
/)
// Timerd_Init
)~
// Configure Timer4 to auto-reload mode and to generate interrupts
// at intervals specified in <counts> using SYSCLK as its time base.
//
void Timer4_Init (int counts)
{
char SFRPAGE_SAVE = SFRPAGE; // Save Current SFR page
SFRPAGE = TMR4_PAGE;
) Rev. 1.3 33
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TMR4CN = 0x00; // Stop Timer4; Clear overflow flag (TF4);
// Set to Auto-Reload Mode
TMR4CF = 0x08; // Configure Timer4 to increment;
// Timer4d counts SYSCLKs
RCAP4 = -counts; // Set reload value
TMR4 = RCAP4; /7 Initialzie Timer4 to reload value
EIE2 |= Ox04; // enable Timer4 interrupts
TR4 = 1; // start Timer4
SFRPAGE = SFRPAGE_SAVE; // Restore SFR page
}
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/)~
//

// AUTH: FB

// DATE: 18 SEP 02

//

// Target: C8051F12x

// Tool chain: KEIL C51

//

// This file contains routines used by the code banking example in ANO30.
// All routines in this file are located in Code Bank 2.

//
[/
// Includes

[/ —————————————
#include <c8051f120.h> // SFR declarations
[/
// 16-bit SFR Definitions for “F12x

// -
sfrl6 DP = 0x82; // data pointer

sfrl6 ADCO = Oxbe; // ADCO data

sfr16 ADCOGT = 0xc4; // ADCO greater than window

sfr16 ADCOLT = 0xc6; // ADCO less than window

sfri6 RCAP2 = Oxca; // Timer2 capture/reload

sfr16 RCAP3 = Oxca; // Timer3 capture/reload

sfr16 RCAP4 = Oxca; // Timer4 capture/reload

sfri16 TMR2 = 0xcc; // Timer2

sfr16 TMR3 = 0xcc; // Timer3

sfr16 TMR4 = 0xcc; // Timer4

sfr16 DACO = 0xd2; // DACO data

sfri6 DAC1 = 0xd2; // DAC1 data

sfrl6 PCAOCP5 = Oxel; // PCAO Module 5 capture

sfr16 PCAOCP2 = Oxe9; // PCAO Module 2 capture

sfr16 PCAOCP3 = Oxeb; // PCAO Module 3 capture

sfr16 PCAOCP4 = Oxed; // PCAO Module 4 capture

sfri6 PCAO = 0x¥9; // PCAO counter

sfri6 PCAOCPO = Oxfb; // PCAO Module 0O capture

sfri6 PCAOCP1 = Oxfd; // PCAO Module 1 capture
[/
// Global VARIABLES

[/ -

// Global CONSTANTS

int code SINE_TABLE[256] = {

0x0000, 0x0324, 0x0647, 0x096a, 0x0c8b, OxOfab, 0x12c8, 0xl1l5e2,
0x18f8, 0Ox1lcOb, 0x1f19, 0x2223, 0x2528, 0x2826, 0x2blf, 0x2ell,
0x30fb, 0x33de, 0x36ba, 0x398c, 0x3c56, O0x3fl1l7, Ox4lce, 0x447a,
0x471c, 0x49b4, 0x4c3f, Oxd4ebf, 0x5133, 0x539b, 0x55f5, 0x5842,
0x5a82, 0x5cb4, 0x5ed7, 0x60ec, 0x62f2, 0x64e8, 0x66¢f, 0x68a6,
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Ox6a6d, 0x6c24, Ox6dca, Ox6f5F, O0x70e2, 0x7255, Ox73b5, 0x7504,
0x7641, O0x776c, 0x7884, 0x798a, Ox7a7d, Ox7b5d, 0Ox7c29, Ox7ce3,
0x7d8a, Ox7eld, 0x7e9d, Ox7f09, Ox7f62, Ox7fa7, Ox7fd8, Ox7ff6,
OxX7FfFF, Ox7ff6, Ox7fd8, Ox7fa7, Ox7f62, Ox7f09, Ox7e9d, Ox7eld,
0x7d8a, 0Ox7ce3, 0x7c29, Ox7b5d, Ox7a7d, 0x798a, 0x7884, 0x776c,
0x7641, 0x7504, 0x73b5, 0x7255, 0x70e2, Ox6f5f, Ox6dca, 0x6c24,
Ox6ab6d, 0x68a6, O0x66¢cf, 0x64e8, 0x62f2, O0x60ec, Ox5ed7, Ox5cb4,
0x5a82, 0x5842, 0x55f5, 0x539b, 0x5133, Ox4ebf, 0x4c3f, 0x49b4,
0x471c, 0x447a, 0x4lce, O0x3F1l7, 0x3c56, 0x398c, 0x36ba, 0x33de,
0x30fb, Ox2ell, 0x2blf, 0x2826, 0x2528, 0x2223, 0x1f19, 0x1cOb,
0x18f8, 0x15e2, 0x12c8, OxOfab, 0x0c8b, 0x096a, 0x0647, 0x0324,
0x0000, Oxfcdc, OxF9b9, Oxf696, O0xF375, OxF055, Oxed38, Oxeale,
0xe708, O0xe3f5, Oxele7, Oxdddd, Oxdad8, Oxd7da, Oxd4el, Oxdlef,
Oxcf05, Oxcc22, 0xc946, 0xc674, Oxc3aa, 0xc0e9, Oxbe32, Oxbb86,
0xb8e4, 0xb64c, O0xb3cl, O0xbl41l, Oxaecd, Oxac65, OxaaOb, Oxa7be,
Oxa57e, 0xa34c, 0xal29, 0x9f14, 0x9dOe, 0x9b18, 0x9931, 0x975a,
0x9593, 0x93dc, 0x9236, 0x90al, 0x8fle, 0xB8dab, 0x8c4b, 0Ox8afc,
0x89bf, 0x8894, 0x877c, 0x8676, 0x8583, 0x84a3, 0x83d7, 0x831d,
0x8276, 0x81e3, 0x8163, 0x80f7, 0x809e, 0x8059, 0x8028, 0x800a,
0x8000, 0x800a, 0x8028, 0x8059, 0x809e, 0x80f7, 0x8163, 0x81le3,
0x8276, 0x831d, 0x83d7, 0x84a3, 0x8583, 0x8676, 0x877c, 0x8894,
0x89bf, Ox8afc, 0x8c4b, 0x8dab, 0x8fle, 0x90al, 0x9236, 0x93dc,
0x9593, 0x975a, 0x9931, 0x9b18, 0x9dOe, 0x9fl4, Oxal29, Oxa34c,
Oxa57e, Oxa7be, OxaaOb, Oxac65, Oxaecd, 0xbl141, Oxb3cl, Oxb64c,
0Oxb8e4, 0xbb86, 0xbe32, 0xcOe9, Oxc3aa, 0xc674, 0xc946, 0Oxcc22,
Oxcf05, Oxdlef, Oxd4el, Oxd7da, Oxdad8, Oxdddd, OxeOe7, Oxe3f5,
0xe708, Oxeale, 0xed38, OxF055, Oxf375, OxF696, OxFOb9, Oxfcdc,

};
/-
// set_DAC1
/)
void set_DAC1(void)
{

char SFRPAGE_SAVE = SFRPAGE; // Save Current SFR page

static unsigned phase_acc = 0; // holds phase accumulator

int templ; // temporary 16-bit variable

// increment phase accumulator

phase_acc += phase_add;

// read the table value

templ = SINE_TABLE[phase_acc >> 8];

// Add a DC bias to change the the rails from a bipolar (-32768 to 32767)

// to unipolar (0 to 65535)

// Note: the XOR with 0x8000 translates the bipolar quantity into

// a unipolar quantity.

SFRPAGE = DAC1_PAGE;

DAC1 = 0x8000 ™ templ; // write to DAC1

SFRPAGE = SFRPAGE_SAVE; // restore SFR page
}
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// bank3.c
/)~
//

// AUTH: FB

// DATE: 18 SEP 02

//

// Target: C8051F12x

// Tool chain: KEIL C51

//

// This file contains routines used by the code banking example in ANO30.
// All routines in this file are located in Code Bank 3.

//

[~
// Includes

// Global CONSTANTS

void toggle_led(void)

{
LED = ~LED;
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